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II‘ Learn in English

The menus are context sensitive. This means that those menu items are
available that are relevant to the work currently being carried out. If the
cursor is located in a text, then all of those menu items are available that are
needed to edit the text. If you have selected graphics in a document, then you
will see all of the menu items that can be used to edit graphics.

File

These commands apply to the current document, open a new document ,or
close the application.
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Edit
This menu contains commands for editing the contents of the current
document.
View
This menu contains commands for controlling the on-screen display of the
document.

Insert

The Insert menu contains commands for inserting new elements in your
document. This includes sections, footnotes, notes, special characters,
graphics, and objects from other applications.

Format

Contains commands for formatting the layout and the contents of your
document.

Tools

Contains spelling tools, a gallery of object art that you can addto your
document, as well as tools for configuring menus, and setting program
preferences.

Table

Shows commands to insert, edit, and delete a table inside a text document.

Window

Contains commands for manipulating and displaying document windows.

Help

The Help menu allows you to start and control the OpenOffice.org Help
system.
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23- To protect the cells from being changed / viewed / printed according to
your settings in the Format Cells dialog box, choose .............
a- Tools = Shared Document
b- Tools = Protect Document - Document
¢- Tools = Protect Document = Sheet
d- Format = Sheet—> Hide

24- Which Menu contains spelling tools?

a- Format b- Insert
c- Tools d- View

25- For Inserting new elements in your document, use ........ menu.
a- File b- Edit

c- Tools d- Insert
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Use the Unfiled Notes section when in doubt
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10- When you don't have time, where should your notes go?

a- All Notebook List

b- Unfiled Notes Section
c¢- Personal Notebook

d- Work Notebook
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II‘ Learn in English

Open a site from Office SharePoint Designer 2007

To open a SharePoint site, you must have at least the View permission for
that site. This permission is included by default in the Full Control, Design,

Contribute, and Read permission levels. If you don't have the necessary
permission, contact your server administrator.

As an alternative to the following procedure, if you have recently opened the

site, you can point to Recent Sites on the File menu, and then click the site
that you want to open.
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1-  On the File menu, click Open Site.
The Open Site dialog box opens.

By default, the Open Site dialog box opens with Web Sites selected on the
My Places bar and displays all sites that have been opened by using Office
SharePoint Designer 2007.

2- In the Open Site dialog box, do one of the following:

e In the large list box, click the site that you want to open, and then
click Open.

e In the Site name box, type the URL of the site that you want to open,
and then click Open.

For example, you might type http://My_server/My_site.

Note: No folder or site names appear in the Site name box until you either
start typing or click the arrow.

3- If there is currently another site or file open, the site opens in a new
window.
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II‘ Learn in English

Tables

Tables are the core database objects. Their purpose is to store information.
The purpose of every other database object is to interact in some manner
with one or more tables. An Access database can contain thousands of tables,
and the number of records each table can contain is limited more by the
space available on your hard disk than by anything else.

Reports

You can display the information recorded in your tables in nicely formatted,
easily accessible reports, either on your computer screen or on paper. A
report can include items of information selected from multiple tables and
queries, values calculated from information in the database, and formatting
elements such as headers, footers, titles, and headings.
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10- Which object do you use to store information on Access?
a- Table b- Query
¢- Macro d- Form

11- Which object do you use to print information on paper?
a- Table b- Query
¢- Report d- Form
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II‘ Learn in English

e A table is just one of the types of objects that you can work with in
Access. Other object types include queries, forms, reports, pages,
macros, and modules

e Tables are the core database objects. Their purpose is to store
information in Database.

e You can display the information recorded in your tables in nicely
formatted, easily accessible reports, either on your computer screen
or on paper.

e You can use the Report wizard to get a quick start on a report, but
you will frequently want to modify the resultant report; you can do
this in Design View
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8- Which object is used to display the information recorded in tables on screen
or paper?
a- query b- report c- table d- form
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II‘ Learn in English

Create a basic diagram
1- Start Microsoft Office Visio.

When Visio starts, several windows appear. For now, all you need to
work with is the window titled Template Categories.

2- In the Template Categories window, in the list of categories, click the
General category. All the templates in the General category appear in
the central window.

3- Double-click the template titled Basic Diagram.
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Connection points

A connection point is a special point on a shape that you can “glue”
connectors and other shapes to. It looks like a blue x ( ). When you glue a
connector or shape to a connection point, they stay connected, even if one of
the shapes is moved. Use connection points when you want connectors or
shapes to stay connected to specific points on a shape. If the shape you want
to glue a connector or shape doesn’t have a connection point where you want
it, you can add one.
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Attach devices

To attach devices to the Ring Network or Ethernet shape by using the
shape's built-in connectors:

1- Click the Ring Network or Ethernet shape.

2- Place the pointer over a control handle <. When the pointer changes
to a four-headed arrow, drag it to a connection point = on one of the
device shapes.

When the device shape is correctly connected to the Ring Network or
Ethernet shape, the connection point turns red, indicating that it is glued.



Details
Hide

Hub

Label

LAN
Monitor
Peer to Peer
Peripherals
Ring
Router
Store
Switch
Topology
Type

WAN
Work Station

4.0303‘ I

0055 (R

00 S g LW
65 oK



SheSS slal sl n8ta 55 1 S ylge dilasy

A S 4l o1 8L ol 0153

Jlao 4oX>

Sloslaiwl g aSils sl a4y ol,81 g o ylojlus dacS b aSils (YL Jlews Sl s azgs b @
O 3 5 9903 aseien |y Bam b il (g yismalS & (o2 (sl wailen 5T (555 o
S38le 0 Gleo )57 51 (G o,S (S8 slad a4y o aSl ol S g Al agd 4 pladl

Ol an aS wig b o e pb dn Al i g 7y b S Bub Al 0 g8l gl @
slaganes 5l sl 5 sl (o> G ganes S oo 4D Goips b S5sln s
D Jglaie

ard leislo (Db ald g9, 5l Wb Il il v Gleisle S o ass Shb gl @
u_)|).>QHWULAABSLE)‘?¢QMJJK)5J6LEMM90MWd.iw
il Sl L YL e b 5 B &yale jo aSlils LS a5 0ges azgi Wb b o
9 (At Dl ple g gy @Sed i p slaore AlE (69) Wb peizes

Template Categories o3 3l Visio doli p ;o el B Sl a0l pl Sho olml 5l @
Diagram 43| Featured Templates ,o 59 >g0 slasSl 5l 9 Lol |, Network axwos
2,5 SIS 0,y el Ceas o Create aeSs (g9, 5 <l |, Basic Network

S, JUE coYlas! L L5 (PC) pamels 5l o le aSl sl o b 3l S0 @
<y g (Router) ol s (Hub) Glo (NIC) aSls &)lS” (Switch) gew s Rack)
(Print Server) ,g yu

Oezraad ol Lo, 5 SIS ISl (g9, ol aSs Jal 4 e 0,5 adlsl gl @
2,5 pladl e Coll a4y o 098 00l ioled ()

319 00,5 Ol 1) Add-ons as 38 Tools (sgie ,o ol S jo o & 5 1380 e gls @
General 45bj ;o 0235 |, Number Shape 435 Visio Extras gs—i3b (g9 )
AlLS Lo 10 o waS SIS OK aaSs (g5, g 00l poss 095 aiules 5l 1) basy 38
Aamles Ol wies o)leds e o aS 1) IS



oM sl ) 5 Kia b il s g 38 Gagfn = lFel) yodl o JS @y

Sty LIS L it a6 ol S35 SIS il s YYY
oI5 dallias o ,lach YoFY/YYE/N/Y o Lo
Sk (9903

T (5 3 gm0l ASTl Sl | Slual 51 5590 plas” )
599 o)y S pae =0 ey Jols -7

00995 0 4% Dgb o0 l,8 1 AUl )0 (BO g pw T Cule, b 4 Juilgdac gosoay - ¥

S =0 JESl e mg NS s 2 003 ey — |
bl oo LaSuls (20 gy Joho (bl p2 a5l glgil 51 4y 357 plas -
Co il -9 LAN -z WAN —C  j5ym p (se — A

oo 0y dmy Al 9 25 Sy G bl dleciw o] (wlul 4 (gladidii g 25k -F

99,10 pb ax (09l o0

SSS9n -0 Gt — T ol —o el Jlasl -l
plasl (o) a1 ()T 50 Bt (ABlS b (381 5 0091 4y 3aS 5 00k Gy plas —0
€0 55 (s
&lo,bw —0 b -l
<ol - S d
oLzl aiwd plas Template Categories Coowwnd 3l Al by ol ,SLo ol (510 -F
o940 o0
General - Flowchart — I
Network —o Database — g

Gly i wlod gl g (g b JBCU! 6l ylo Visio 4ol y» Professional asews (o o5J! slas’ -V

¢ aw! 45.»». W
Basic Network Diagram — o Website Map—<&J|
Rack Diagram —o Detailed Network Diagram —g

§ s 45 (61521 (i 3 k0 932 4035 ol —A
Rack -o Modem -z Router - Hub - &I



SheSS slal sl n8ta 55 1 S ylge dilasy

Vv ot aly o1 KL skl 30 g5
93,10 0 1,15 L JSC& of podd 4y Lodld 0 jusd (gl 4y 35 plas -1
Save As —o Save -l
Shape Data Window —o Create - g
39,50 )1 4 o151 50 b JSi (5,195 0,Loud (512 9o plas’ -+
Tools —o Insert — g View-o File —-J|
11- When you place the pointer over a control handle, it change to ................
a- Red color b- A four-headed Arrow
c- A two-headed Arrow d- Blue color

fewwl olay 35 a> lylo 9 8,18 g0 5 4> Label Shapes o y2s —\Y
LS R SCULEESUNCES LI 275,

$355 0,19 o151 58 1y 45 5 ygemals Sy TP oo (g o0 WigSz 1Y
§3,15 g0 4,5 a> Tools seoo yo add-ons a5 —\¥

o5 (39037

oS 033 1y T g 00,8 b aSis ath wed Gl i (6 geels Culs gl -

S Joo U 65 smenlS b (51 ol 5o o0,ls 525 6yme A e U1 Sy epylazslus 5 4o —Y
DS s S 0,33 o olS Slym by b | aSd 4 anS bl Al V0 b glo b
sl ansls edly ol asis



o8 )55 salg

DB 4 1,5 a5 3695

(web) Oloy

s gk

¥ \

A O VYK

:ds JngoJLla'lllJ:SbéleS aalg O:d WLhajlua,:
S AT |y sofs ofSly slatt =
e b s el Lot




SheSS slal sl n8ta 55 1 S ylge dilasy

vva DB by al Sl e 5 i(galil g3

wlls

-

il 55 S 5 el i Sy (soga sl & 00l ol L FAeNBI Sl s
SSb ;R @)le 4285 Sl s (Seg 2SI SIGL 4wl o8 Glae @ (lgiee T (Sl SOL
lepins iz S cwl (6 gl S ools gla L 5l dcgemme S (gl Sie Sledb
s plen wnles Jleel pla bl iz 59, 1) 0o sl Shos 5| (Slacgae (S, 4 wiilsi o0
Skl STL Lol 5 wad ) F ol QLS e Access lble 5 4 b e sl ySaxly (o aS
e L el 5 L o o gz ol s o 0,058 Lo 53 1a,55 , 85 st b Jyor
ezt LagT ey BL | 61,85 5 Jgozr olml (Sl Visio 153le 5y auiS oo 185 bLS |
Soban sy A5 Lelw as oS o S5 GGl cplo)ls 0925 Jeax sl 0ges (aseine
SSL L bls)l e Visio ly8le,5 L )5 Sasly oul 0005 2l silwesly 51 L8 Sledbl

SIS TE

DB a3l pf 1 ol 1

Software and «i_ws Template Categories Cuowd I Visio asli,y ;o0 DB aly ol SLo sbx! 5l
Database Model Diagram ¢3! Featured Templates ;o ss>s50 slasSl 51 g ll |, Database
(3= Ss) anles SUIST 0y el Cows jo Create daaSs> (59, 5 ol |

Entity ¢obls g0 Jold (5,8 jimy jo-bds a5 558 o 00ld ioled o i 4o ¢ yinled dxio o
axid_o yul o Database Properties o > ¢ Shape 4.>U ,» Object Relational 4 Relationship
(A=Y JS8) il



DB aaly al SLis alal 4-) Jsud

Shapes a.>U

Database Properties o >

paeu b dadis 4-Y S




Sl St J gt 4—Y

Joaz o o 5l Sleogas Jguz o ok ool oL o Jolax Sbled ol SLos o o Jgax
b a5 oSl 5l oolatnl b asler co Lol 05 co Jolis |y bosls £45 9 Lol oS daygiw b
doles Jlasl Sl 39250 o gz o b izl |y b Jgu> DB

Joda wialw 4-Y-)

JS—% Object Relational L; Entity Relationship gl 5l cpnmw 5 40 Joo S 09531 (51
Database o,y b auS SIS pp i dxis 10 S0 (65, (s eSS o )5 40 4 | Entity
Ailg s diy 35 5o Clsal g Categories a>U 5l oolaiwl b oyt o) o 2045 ,alls Properties

(AT JS8) 0 e 1y Jgaz Sleogas

pac i da J9a 938! - Jsud

o Sloosas (5 s 5 01,5k & Jpor 353310 JwE

Software ai_ws sl p sy ganaiws 5l Getting Started , g 05 |>1 1, Visio 4l -9



oMl bl 5 Sia 3 eyl @laa 5 8 glosle — elaial H sl 5 S ol
ety SIS G 1 laiticel Al G LI585 e S it als VYA
al5T dalllas 0 yladh Y=YY/YE/\/Y o ylasks

.35 1, and Database

U asles SIS Lls Database Model Diagram (g ¢ gl Coond [0 09250 slagSIl 51 Y
D 0318 iulad s i dxao

DuliSS e i Ao @ |, Entity S Entity Relationship oyl 51 -Y

,» Database Properties o, >y L5 o oS SCS (a5 azxio ,0 ool 4Bl Jgaz 59, —F
Ded ool jisled dxio ol

5 g aib ead olss! Definition a3 oS asS ol luebl Categories caud o -0
A2 i "ot a4 |y Jea> sls Physical name Jolie joLS o Cl o

(A-F JS)

Database Properties o yais 3 Definition diu 38 4-Y s

J93a 43 333n ahd 93,5 adLAIR-Y-Y

ol sl 1) Slogas L asliin ol 4 gaas ald wealyse col (Se ¢ Jgaz colajl an
Database o, ;o Categories Ceowd )0 aosls g4 9 Lol 0dS (y ya5 Yo WS Cyetd 35290
aL3 oL Physical Name ,olS jo cwly Coaw jo 9 0uS SIS Columns iy 55 (59, Properties
A8 S50 30 9 aiS atioe |y ol 5 eols e Data Type Ceond [0 .0uS i l) jlais g0
Sy s laald (5,5 ABlal (gl oy dle | Req'd a3 098 Lot ald (nl walys o
3 1y mgls 150 Lol Losiitns b auslod Cymeed |y ayazr alid claseia g pb g 0 SIS Add aeS's
&l g Bdit asSs 5l lald Ola sein posd Sy dpled ol g ools I3 Physical Name ail>
84 oo ooliiwl Move Down g Move Up slaasSs i lagy| olal>



Joaz 4y ald jog38l:Y JME

30 Cewly Carws 50 g 0uS SIS Columns a5 (g4, Categories Cwond ;o0 ) Jlo jo0 -
A i " el o )lal" 4 ) gt pb Physical Name  Llie ,olS

"s5" Physical Name cood )5 gl adlal gasaz ald b ous SIS Add aeSs> (55, Y
asS b

Ales ddlol Mgl ooz a4y i 5 eed 4 i )" e a5 g " Solgils ol slaald -¥

A bl ] eols g45 laald 51 G o (sl Data Type cwand o -f

Ay cdle |y Req’d 438 0SS Caslon " o goetils o lad” ald yoe Null 5l assl 6l -0
(A-0 JSs)

Laulsd Bls guad (uand 9 Jgun da ulid (a9 ¥ 4= OJsd

(Primary Key) ol 3uS ¢y 4-Y-Y

U3l Jsoz 59 o bL3 | slys 355 oo snlizial ozl 5 Lol slaanls 51 Jslaz o bL3 | (sl
oS s |y s e ol oS sl sl sl Lol oIS slls il S



ol ol ) 5 Saa 8 o l0 sl 5 (38 glele — elaial el 5 58 =500
<8y LIS G 2 ylilicad als Gl Sl8la 5 5alS tayluilical als YA
5T axllias o lash YRYY/TY/N/Y o jlad
bl SIS RIS e 5 azmio )0 583 5550 52 (55, )
2SS SIS Categories cuawdd 5l Columns 438 (g9, Database Properties o ,ox0 ;0 -Y
A S PK A 38 aulos )7 Ol ol oS olgie a5 a5 gald blas o -

B

A4S SIS Columns a5 (g4, Categories Ceownd jo ¥ Jlie 0 =)

aS > sl Byre Jol ol laie 4 PK a8 Ol L1 " Ggmiils ojled” old =Y
(=7 JS5) cwlylo |y ol aldS colB g 009 0,8 4 pasin o gmeiils o)leus

U933 53 sl S (pauas A7 gt

ceade 1) PK a5 ¢ oS o bl Lol oS laie @y |y gald a5 Sloj 1>t Jlgu J}'
Fogu o0 005 Cuadle 5045 job 4y Req’d a5 iy oo

sl (o B3 §1 Joo!t 1Y

s g 23nlesle o (> g Lol oS s 5 gz LUl wsls oL o 4 Sl



SheSS slal sl n8ta 55 1 S ylge dilasy

| DB by al Sl e 5 i(galil g3

Wgd oo Cule, Jgol pl 5 00l oL 61,510 s i )0 )l cago i Dledlbol 4y

Jolaa oy bli)l -Y'-

A5 g sy el ol allS (gl sl sz 5| e Bl o Jsa o LS ol sl
S, Entity Relationship |, Object Relational :ysLls 510,08 S5 Jls sl Lol aldS™ 6l ls
IRVRA CIPUUWIIP'E T I VR JEERET g W]

Do wlon , S Szl T 5l (ol adS aS Jgam dawg 40 Gegle b 1y sasms Jlas! SO
39 Jate Joaz dm oaimoJlas! ;w L5 aiS o) |y Gusle 0lS g0 508 S5 4 g
(A=Y Ss)

Jglaa JLasl 4-Y Jsu

R S5y & Jevx Sl 5l G g 00 03 Jeoz bawg 4] ssms Jlail 53 s Bayb e
35250 Jgl g 0 hol odS Al L al v (guld pgo Jouzyo ST.aaS ey |y ugle olS ‘.\.{\)a
g o aslsl Jgu @ B ads SO il

ay;5 Database (sgie 5l g —od 00ls iolod caias Jlas! bylas leis ol Sbo jo ST :dda @
a_b; Database Document Options o,slowe ,0LS jo .05 SIS Document (gq, 3 Lzl |, Options
Wi Cedle |, Relationships 435 Show a>U ;0 g 00,5 Jleé |, Relationship




e srsr sl

aS wlsl pl Fho ay 1y "slbwl " " e ye" s Jgux ¥l o )

ald g aulian 1) "aslg slaws™ 5" o pU " " e y0 ojled” glaakd M o Jou 4 Y
WS bl Lol oS laie 4 1) " oy 6 Ll

AaS" ol g oogad iy, 1) " Solgils pb" el SMolislas™ slaald Sobul" Jgam o -F
S Sl e ol als plsie an ) ol

el o0 o] A-A S illae "oliwl” 5 " ey M gmiils” Jsoz dws siS| —F

PK Sdia fnds P |l
A
pl BLET R
o gla i e
ol
PR [ fes
et pld
2aly sles
4-A Jsd

DS e i dao 4y |y Relationship oases Jlasl Object Relational ol 51 -6

23 S5 A Jgaz a5 (Sl g 0o Moliul” Joua lee @ ) ssms JLasl el e -F
WSy |y egle ol cas ools yioles

2 1) "oy g TSl Joaz 93 5 03 (0" Jeux ol ] easms Jlail o5 e -V
led Jate

O oy gz 50 a8 el Moliwl 0S™ ald Maliwl” Jgaz jo ol oS a8 Ll 5l —A
a8lol " yoy0" Jeaz 4 (FK1) (>, ol laie 4 "ol a8 ol s 95250 (gl
(A= USK8) 99 o0



-4 Jsub
Ao |y "emmale” Jaam 0gd oo A3 calie lgmmiils lawg oy 2 ccud ek 4 -8
aBlol " " Jeaz an " gemmisils olad” (>l oS ol Jate "oy " Jgo

[

g
aadty land

FRL | i
yan S

A=\ v s
oo osled oy ol oS G ol oS s ] el oS ald M ey Jeae jo e
A=V US) ols wnlgs JSas 1) M oy Jgae ol aldS sl oS



oM sl ) 5 Kia b il s g 38 Gagfn = lFel) yodl o JS @y
Gyt IS S it als ol I3l IS lailicat als VAT

ol5T dalllas o Lok YoYY/YE/N /¥ o ek

4-\Y s

bli)l 4 ) yuss 4-Y-Y

ol 00,5 w8 S 1) blo a0y pad Sl do ooz o bl )l slowl 5 ogdle Visio asl
a_>U ,o Database Properties o, =iy | g aaS S5 Jols oo Jlas! S (g9, jelaio cpay
oLl ) bLs )l ax o Cardinality ceowd )0 .0uled bl ) Miscellaneous s 38 Categories

LA-VY SS) ass

sloaa 3T 5 o> 4 So lably,l L culize One or More ¢ Zero or more (glads ;5 - @
ik Exactly One 4 Zero or One sladas 3§ oS 4 SO bLs I b caslie




SheSS slal sl n8ta 55 1 S ylge dilasy

YA DB ol g8 g3 sl
Connector Tool b bl )l stxsl 4-Y-Y
= Standard |5l a5 o Connector Tool 5ol 5l les oo b Jgaz yu bl sl 6l

5oy 5 Se il e wasS SIS Il lss jo Connector Tool 13l (g9, )15 ol gl 0,5 oslatul
5 43l 455 s | gl 9SS S 505 055, 4 Jgar antlo B oy 5 Jsaz Lams
ly gbs 0,5y 508 K0, @ Joozr il o5 Glej )0 5 00 ;505 (Ju Lawg 4], 5o L

Mgl oo o 1m0 4 Jou 90 9 Wgd oo 00l ioled 50,8 S5y 4 Jlail alais g0 0uS s,

cbubl LB3a 4-Y-¢

Sl ot Bpate pl SLos 4 Lo oz (o BLS)I L Jguzr (9905 3L 5l &5 (550 50
o 5 Ao 10 o (g9, ceaims Jlasl b Jeax i sl amles Bax 1) lag] o) 4 oles o
o5l L Delete Object o,gle j0LS 1o .0 ,Lad | odS axas 3l Delete oS 5 00,5 SIS
NO ay35 a5 (Jys0 ) 05 oo Bl abgype 4 105 g e § aeio jl ooy Sl ol Yes any 35

(AN JS8) '35 o oms 5 dmio 51 o5 o DUl o wmlos bl |

Delete Object o glas Hals -V s

3lepols QLS s ol e 4 a2 g5 b aS 05 s, 1,500 s 8 5l oo ansle glaosls oL sy g5 o0 )
oy ooy 5o wed Gl No a5 Delete Object jolS )0 a5 Syae j0 .Col odd (g loogs Cdlas cpl 4 o)lal
5 o0l b ,S0g5 jeboa, Tables and Views o, (Reverse Engineer Wizard) se>ge ools oGl 5l oolaiwl b ol SLo
A g iod Gl 0SS S0 ey @ la_xm oy ol 5l es 00,5 Bl w3 0 AT 1) (Jsax g auales 018

.S oolazwl Database - Reverse Engineer ... sg%o ;I Reverse Engineer Wizard



b Jsax o bl )l B> 10 JL&E

S g oS SAS Mol 5 " ey o Jgus o sass Jlail g9,y Jeao T e o -
Ae2o Les 1) Delete

Awles Ol [y No as 35 Delete Object o jglxe j0lS™ ;o =Y

"oy Jedz 50 jemd Ll ould B e 5 3l oaimo Jlasl JS 4T ail anils axg5 -Y

A-VE US5) ol Jgam 50 bL3 | Sl "sbial 08" >l oS

PH, fs . et PK |l &
Fr RN
s s o
ol &

PE_ _ _lmpsfus
PRFKZ |55
T
PR T
FKA T e

Jgua g9 suiay Jleadl Jsib Bia 4V Y i

Sgds 93] BA> Jae b oS O Edit g5 511, Undo a5 ¥

Delete w1 5 03,5 S5 " )0 5 "sbewl” Jgazr 99 o oias Jlail S5 (55, ;500 L -0
RVES R

A3 1y Yes iy 58 Delete Object o yglxe jolS jo b ol —#

ol Bl " 0" Jgao 3l 5 MoliwlaS™ > oS S 008 e cdnlin Jlasl i L -V
aslaa Sy Jlas! §l 8 cas by an Jou 90 g aid, Cewo 1 JolS IS bl 9 el
(V0 %)



eSS (550l (sla 8l 55 1o dilasy

YAY DB b ol Sbs aves 5 1 2l g3

— A
PE | ot o s PK |di &
£ il g
oSl glli ol &
T

P 8 i

o
dal p 3dad
FlA | oo iy o et

Joua 99 s Jleadl B3 410 S

II‘ Learn in English

Set a primary key

Relationships use primary and foreign keys to map rows in one table to
corresponding rows in another table. At least one of the tables in the
relationship must have a primary key in order to establish a relationship.

1- Double-click the table in your diagram.

2- In the Database Properties window, under Categories, click
Columns.

3- Select the PK box for the column for which you want to use a
primary key.
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Use Case Diagram

A use case diagramis a diagram that shows the external actors who will
interact with your system and how they will use it. The diagram consists of a
system boundary, actors, use cases, and use case relationships.
(communicates, uses, and extends) In a use case diagram, the communicates

relationship "= defines how an actor participates in a use case.
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